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Al Demystified: How to Effectively
Use Al to Improve Your Quality
Management System

Presenter: Mark Cooksey
ISO 13485 Quality Leader, Norton Healthcare
Mcooksey6@gmail.com
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Leveraging Al in HTM Quality Management Systems

e Alls here!
e What it can do and Why it's needed
e How to use Al effectively

e Examples of Al Assistance
o Resolving ISO 13485 Audit Non-Conformities
Performing Risk Assessment
QMS Documentation Simplification
Amazing Presentation Automation
Just for Fun

o O O O
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Have you used Al?




Al can improve your
Quality Management System (QMS)

e Creative Collaborator
o Brainstorm ldeas
o Refine details
e Proofreader
o Improved communication
o Simplify & consolidate documents
e Problem Solver and Coder
o Perform statistical and risk analysis
o Create VB and HTML Code:
s Generate Powerpoint presentations
m Create Excel process map
=  Websites

MD: PO
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vs. 4

Can you connect all the dots with
only 4 continuous straight lines?

(You) Search commercial websites (Al) Generates a solution

(You) Read the documentation = " (Al) References websites

(You) See if it solves your problem (Al) Checks to see if it works

(You) Keep searching other sites = 2 (Al) Revises the solution as needed
® @ @

Hint: the lines can go outside the box
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Connect all the dots by drawing
4 straight continuous lines.

Al can help
e ” ¢ you think

outside the
'3 S 0 box for new

solutions

0
0
<
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Norton’s Challenge : Two ISO Certifications

CLAUSE 5.0

CLAUSE 4.0 MANAGEMENT

ISO 9001 CERTIFIED UALITY
N %ANUAL RESPONSIBILITY ALAUEE B0
N ORTON DOCUMENT HUMAN
HEALTHCARE CONTROL RESOURCES

LEGACY APPLICATIONS
SUPPLY CHAIN
CORPORATE POLICIES
SOPs

CLAUSE 7.0

CLAUSE 8.0
QUALITY
IMPROVEMENT

PRODUCT / SERVICE
DEVELOPMENT

o @‘5}-

ISO 13485 CERTIFIED
MD: P!
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Challenge #1.
Close out ISO 13485 audit
non-conformances




The Problem: Auditor Endless Loop

ISO 13.4 85 Corrective
Audit Action Pl CAP
> ction Flan Approved?
Non- CAP
Conformance

ENDLESS LOOP
The auditor was Redo )

rejecting CAP over CAP
and over

MD:XPO)
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Reasons for the Auditor CAP Rejections

Auditor: “Clinical Engineering has failed to:”

e Complete the CAP form correctly.

e Demonstrate understanding of the ISO 13485
standard

o ldentify the root causes of the Non
Conformance (NC)

e Define Short and Long Term Solutions

e Explain how the solutions address the root
causes




Help! Effective Al prompts \3%9;{

e Provide context: Give background information or perspective.

e Be specific: Clearly define what you need Al to do.

e Set expectations: Ensure the Al can achieve the desired outcome.

e Evaluate Output: Compare Al results to your expectations and
experience

e Dialogue: Provide feedback to Al to adjust accordingly.

MD:XPO)
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Provide Context

“You are the auditor. See the attached non-conformance for context.”

0% Response:
-:ﬁ"“ P

Al summarizes and confirms its understanding based on its own
research and your attached information.

Al asks: what do you want to do?

“imw Enghind v czner - 0L 20



Provide Context

you are an 150 13485 auditor who recently conducted a recertification
audit at Norton Healthcare, an in-house servicer of medical

equipment. YOu issued & minor non-conformances and 1 major citing

items from a previous audit were not effectively resolved because
some issues remain. You have rejected the response to RA-07. here is
your email exchange: Hello Mark,

Thank you for your prompt response. Please do amend the finding
detail form for this non-conformity and address the major finding.
Once | receive the updated form, | will review.

“imw Enghind v czner - 0L 20



Set expectations § st oo i o Gt

Liear Iris,

& Let’ S m a ke S u re th e CAP m eets I hope this message finds you well. Fallowing our racent cormessandence regasding Corrective fAction

Plam RA-0T. | have revised the CAPS dooumentation to address the major linding identifisd during

I S O 1 3 485 re q u i re m e n tS . ” the audit. Thank you far your guidance and patiance throughout this process,

Here is & summary of the revized Corrective Action Plan

1. Root Cause Analysis:

#  The root cauze of the non-conformity is identified & inadegquately protectad fizlds in the

R e S po n Se " CAPA Torrn, leading to accidental defetion of crucial information. This oversight persisied
.

due to the continued use of the madificd form without detection,

2. Comection Actions:

»  Heview Controlled Form: We will review the curment controlled revision of “Farm #.5-2-1

[ AI CO m p I ete S a n I SO Corrective and Praventive Action Record few 27 to ensore it incudes the necescary

lancpisange regardding the assessment of impact on the performance of medical devoss and

Com p I Iant CAP) regulatony requirements,

s Irmnmeadiate Form Restoration: Restons the o

ginal verbiaggs of the CARPA Form and
investigate methods to protect critical fields to prevent accidental defetion or modification

of essential information.

» (Generates a letter to . Cormectve Actions
the auditor (Iris) [ i

*  Form Walidation/Protection Mechanis i Implernent a protectionvalidation mechanism
within the CAPA form to ensure the completenass and intagrity of entered data.
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Evaluate Output

“This looks pretty good. | took the CAP and made a few
Changes for clarity. How does this look?”

éj‘f;*‘ Response:

Al evaluates my work and offers suggestions for clarity.

“imw Enghind v czner - 0L 20



Al Strengths —what it does well

« Can decipher meaning

o Has access to expanse of information
o Take an outline and create a book

o Take a book and create an outline

\@M\m\ |
o Rt
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Challenge #2.
Performing Risk Assessment




— Risky Business

e After COVID restrictions, patient census skyrocketed.

e Clinical Engineering was denied access to beds for PM.

e Bed PM completions metrics tanked.

e Al used to evaluate the risks of changing from OEM to
AEM PM.

What are the risks of changing PM? —+
MD:XPO).
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create an PN scone far each ib=m of the Fid of the Yersscare bed (RFM = risk priority. =ach itemn is
rabed 1 to 5 for the folloeing risks: severity |5 & highest) | detection (5 is highest risk meaning difficult
ta detect the failure, freguency {3 is for high ococurrence failare)

#  Creating an RPN (Risk Pdarity Mumbsr for each Itam in the Preventive Maintenance [PM) of the

Versacane hosplial bed Involess asslgning ratings for thres factons: Severlty, Detection, and
Fregaendy, with @ach facor rated fromm 1 o 5 The RFM 8 caloulated by multiplying these thres
ratings (RPN = Severlty & Detection % Fregaensd). & higher RFM indicates a higher priarity for
ackdressing that specific item In the PR plan Below, 11 grovde & hypotheticsl examgle of how you
milght asslge rabings 1o varlous manterance [te

lern 1 Electrical Campamenis
o Sewerty (300 Electrical fallures can lead to patent safery lsaues
¢ Detectlon (3) Bectrieal oies are relathsely sases 1o datect through routine Insgections

#  Freguensy i) Eledrlcal components may have modesate fallure rates due 1o frequent use

RPM for Itein 1 = 5 (Gesserity] = 3 (Detection) = 4 (Fragiuanog] = 60

™
MD:XPO)
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- A failure of the side rail latching mechanisms
can lead to

unintended patient falls
entrapment between the side rails,

. Severity (5):

Side rail Latching Mechanisms




Caster braking system failures make it difficult to

secure the bed causing:
impact patient safety and mobility.
unintentional bed movement
patient falls
Difficulty securing the bed in a fixed position.

Severlty (4):

Caster Braking Systems




Electrical System Component failures can lead to
power outages
malfunctioning bed adjustments
unexpected movements
danger to patients or caregivers.

. Severity (5):

Electrical System Components




Versacare Bed Sub Systems

Item Severity | Detection | Frequency RPN

Side rail Latching

Mechanisms 5 1 3 15

Caster Braking Systems 4 1 3 12 “Help me calculate the

ical .

Companenn 5 |1 |3 15 RPN based on Severity,

Electrical Power Cords 4 1 2 8 Detection , adn d Freq uency

Control Return to Neutral |3 1 3 9 Of Malfu n Ct| on ."

Controls/Cabling

Entanglement 4 1 2 8

Lockout Controls 3 1 2 6 AI evalu atEd RPN

Sleep Surface 4 1 3 12 Bed PM changed to AEM
, : Severity may be high

Head Angle Displ f . . .

assllical:r)llg)e ey 3 1 2 6 Detection of failure is

VersaCare Bed Main 4 1 3 12 Frequency of failure is

Battery

Bed PM changed after Al Risk Assessment




Challenge #3.:
Al Simplifies
QMS Documentation




CE Legacy ﬁ" L New ISO 13485
CE Policies (. Ged Noe = A Quiality System Procedures
SOPs = QSPs

HTM Practices D, N Lean 6 Sigma Quiality Tools
Leadership Training Staff Training
The Joint Commission A DNV ISO Audits

Active Vendor Assessment
Integrated ISO Documentation
QMS Review
Audit Records

Vendor Status Quo
Disconnected Documents
Performance Tracking
CMMS

/0 Legacy 50 1SO 13485

CE SOPs QSPs, Forms
350 [|=|H 258 = bk s 200

CE SOPs Hundreds of NHC Policies and Procedures CE ISO 13485

>1000 | [E]]l | NHC 1SO 9001 |



http://nsite/departments/clinicalengineering/ces/CE%20Core%20Competency/Forms/AllItems.aspx
http://nsite/departments/clinicalengineering/ces/CE%20Core%20Competency/Forms/AllItems.aspx

You

i want to simplify our quality manual. I'm sendin you 2 - 3 pieces of it.

—tEre s The T trstty-itamrat
Manual #: Ck-01
Rewision # 2

Approvals:

Scott Skinmer: — Date:
System Director, Clinical Engineering
kark Cooksey: Date:

KManagement REprEEEntati'.rE

This document has all rights reserved by the Department. MNeither the
whole nor any part of this document may be disclosed to any third
party without the prior written consent of Morton Healthcare
Corporation or the Morton Healthcare Corporation (NHC) Clinical
Enginzering Department, The whale ar any part of this document

=
MD:XPO)
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can you put all this together?

NHC Clinical Engineering Quality Management System (QMS) Documentation
Overview

1. QMS Documentation

NHC Clinical Engineering's QMS documentation comprises:
* Quality Manual (QM) including Quality Policy and Objectives;
¢ Documented precedures per ISO 13485 requirements;
e Department-required documents for effective process control;
* Quality records as per 1ISO 13485;

» Documentation specified by national or regional regulations.

2. Extent of Documentation

The extent of QMS documentation depends on:
e Practicality and applicability;
» Process complexity and interaction; J;

e  Parnnnel romnetence

@ Message ChatGP]

|
MD:XPO)
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Al Simplifies CE QMS Documentation

140
120
100
80
60 83% Reduction!

40

20

BEFORE
mSOP mQSP = SW|

Integrated ISO 13485 with ISO 9001

MD:XPO)
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Al Generates MRI Repair Policy

7 b

lets' search for some complex repair verbiage for MRI and then give a simple step by step instruction for PM.

omplex Repair Verbiage for MRI

omplex Document: MRI repair documentation often includes highly technical language and detailed procedures.

or example:

» Pulse Sequence Parameters: "Appropriate annotation should include the type and times of the pulse
sequence, the number of signals averaged or added (NSA), the size of the reconstructed region, the size of the

acquisition matrix in each direction, and the slice thickness.”

+ Magnetization Coherence: "Loss of phase coherence of the spins results in a decrease in the transverse
magnetization and hence a decrease in the MR signal. In the quantum mechanical description of magnetic
resonance, coherence refers to a transition between different states of the spin system (see multiple quantum

coherence)." !
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Al Generates MRI Repair Procedure from Policy

ISimpllii“'uaw:i Step-by-Step Instructions for MRI Preventive Maintenance (PM)

1. Preparation:

o Gather Tools and Materials: Ensure you have all necessary tools, including cleaning supplies, calibration

devices, and safety equipment.

= Review Safety Protocols: Familiarize yourself with the MRI safety zones and ensure all personnel are

trained and aware of the safety procedures.
2. Initial Inspection:
@ Visual Check: Inspect the MRI machine for any visible signs of wear or damage.

o Environment Check: Ensure the MRI room is clean and free of any metallic objects that could interfere with

the magnetic field.

“imw Enghind v czner - 0L 20



Al Generates MRI Repair Checklist from Procedure

Step Action Completed

Gather Tools and Materials O

Preparation
Review Safety Protocols

Visual Check

Environment Check

Initial Inspection

Magnet Calibration
RF Coil Check
Check for Updates

System Calibration

Software Updates
Run Diagnostics

Clean the Bore

Cleaning and Maintenance
Inspect and Clean Filters

Run Test Scans

Functional Testing
Review Results

Record Maintenance Activities

Documentation

(N {1 [ [

Report Issues

“imw Enghind v czner - 0L 20



Challenge 4:
Automate Powerpoint
Creation from Al Outline




Help me generate VB code to automatically create a PowerPoint
Presentation from the Outline you created. Here is the outline. Slide
1: Title Shade

Title: Al Demystified: How to Effectively Use Al to Develop or Improve
Your Quality Management System

Speaker: Mark Cooksey, DME Quality Engineer, Norton Healthcare
Slide 2: Introduction

Introduction of Mark Cooksey

Objective of the presentation

Importance of Al in QMS

Slide 3: Overview of Al

Definition of Artificial Intelligence (Al

Types of Al: Narrow Al, General Al

Examples of Al in everyday life

Slide 4: Understanding QMS and 1SO 13485

Definition of Quality Management Systems (QMS)

Key components of ISO 13485

Importance of ISO 13485 in HTM |

MD- PO
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Here's a Visual Basic for Applications (VBA) code that will create a PowerPoint presentation based on

the outline you provided:

Sub CreateAIPresentation()
Dim pptApp As Object
Dim pptPres As Object
Dim slide As Object

" Create a new PowerPoint application

set pptApp = CreateObject("PowerPoint.Application™)
pptApp.Visible = True

“* Add a nmew presentation

Set pptPres = pptApp.Presentations.Add

51lide 1: Title Slide
set slide = pptPres.Slides.Add(1, 1) " ppLayoutTitle = 1

slide.Shapes.Title.TextFrame.TextRange.Text = “AI Demystified: How to Effectively Use
51ide.shapes_ﬂlacehﬂldersf_?]_lextr-r-OExtHange.Text = "Mark Cooksey, DME Quality Eng

“imw Enghind v czner - 0L 20




“Here are the instruction to use the VB code to create your
Powerpoint Presentation.”

1.Enable the Developer Tab:

*Open PowerPoint.

¢Go to File > Options.

¢|n the Customize Ribbon section, check the box for Developer and click OK.
2.0pen the Visual Basic Editor (VBE):

*Press Alt + F11 to open the VBE.

eAlternatively, you can click on the Developer tab and then click Visual Basic.
3.Insert a New Module:

e|n the VBE, right-click on VBAProject (YourPresentationName).

eSelect Insert > Module. This will create a new module where you can paste your VBA code.

4.Copy and Paste the VBA Code:
*Copy the VBA code you want to use.
ePaste it into the new module window that opened in the VBE.
5.Run the VBA Code:
eClose the VBE and return to PowerPoint.
eTo run the code, you can press Alt + F8, select the macro you want to run, and click Run.

“imw Enghind v czner - 0L 20



pLt

g .

(01 SUBSTRIFTEIH CANCE

= Prezamiviar] = SoperPoint

Draw  Deagn TatsrRens

e e
L~ el gy
Skl PrssziFonn  C0M
s Adehae Al

RS

BN D Sairdwy, Deceechsr 1

Arirrations

F0EA, eyt fegtores of Posss Soons m ) e dabled

ids Srow

ABMOE
bd= H1= g 1t

[ 1w iz

o

Fesrianbe

Search

Retord  Rewew Vioe

Dewcoper| Help

“imw Enghind v czner - 0L 20



5:2016 - Clause 8)
Measun - ;

orming Product

er
» 2016 — Clause 7.6)
Monitq

is, an

*ﬁl Microsoft Visual Basic for Applications - Presentation1 - [Module1 (Code)] — O X

i% File Edit View| Insert |Format Debug] Run Jools Add-Ins Window Help - 8 X

BE&E-d BaA p A EFY @ s coler
Project - VBAProject X[ TGeneran ¥ | [CTeatePTeSentaton ~T]
= Ca iﬁ Customer-Related Processes (IS0 13485:201e - Clause 7.2)", "Work Ord‘1
Egﬁ VBAProject (Presentation1) 85:2016 — Clause 7.4)

E”EEMD

¢ IModule1 Purchasing (IS0 13485:2016 - Clause T7.4)",

ice Operations

"Process: Use of OEM repl
(ISO 13485:2016 - Clause 7.5)

Microsoft PowerPoint

Production and Service Operations (ISO 13485:2016 - Clause 7.5)",
uremen

. fuipment (IS0 13485:2016 - Clause 7.6)",
@ Presentation Created Successfully

provement (IS0 13485:2016 - Clause 8)",

R

Control of Non-Conforming Product (ISO 13485:2016 -|"

(IS0 13485:2016 — Clause 8.3)

Dis




Al Demystified: How to
Effectively Use Al to
Develop or Improve Your
Quality Management

System

Mark Cooksey, DME Quality Engineer, Norton Healthcare
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Introduction

* Introduction of Mark Cooksey
* Objective of the presentation
* Importance of Al in QMS

i ol otz 4 L



Overview of Al

 Definition of Artificial Intelligence (Al)
* Types of Al: Narrow Al, General Al
« Examples of Al in everyday life

i ol otz 4 L



8%
Understanding QMS and ISO 13485

* Definition of Quality Management Systems (QMS)
« Key components of ISO 13485
* Importance of ISO 13485 in HTM

i o vactzner §- 0L 0



Challenges in QMS Development é‘

« Complexity of QMS development
* Resource intensity

* Interpretation of standards

« Maintaining compliance

i o vactzner §- 0L 0



This works great! How much time would | have spent to draft this
outline and create a rough draft Powerpoint. Compare to your (Al)
time to develop and calculate the % reduction in development time.

I'm glad the code worked well for you!
Let's break this down:

Manual Time Estimation:
1. Drafting the Outline:

e Depending on your familiarity with the topic, drafting an outline with 21 slides, including

bullet points, could take about 2 to 4 hours (research, structuring content, and drafting).
2. Creating the PowerPoint:

¢ Manually creating each slide, typing in titles and bullet points, and formatting the

presentation might take about 1.5 to 2 hours.

|
MD- PO
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Al does the math!

Total Estimated Time:

¢ 1.5 to 6 hours manually for both the cutline and creating the rough draft PowerPoint.

Al Time Estimation:

= Using Al, the cutline was generated and structured in a couple of interacticns, and the VBA code
to automate PowerPoint creation was provided in a matter of minutes.

* Assuming 10 te 15 minutes for cutline generation and code development with Al

Time Savings Calculation:

Let's assurme a manual effort of 5 hours (average) vs. 15 minutes using Al

1. Manual time: 5 hours = 200 minutes

2. Al time: 15 minutes

Mow, let’s calculate the percentage reduction in development time:

(Manual time — AT time)
=1

Time reduction = i}

Manual time

_ (300 15) 285 .
Time reduction 300 = 100 300 = 100 = 95%

Conclusion:

By using Al, you achieved a 95% reduction in development time compared to manually drafting the

outline and creating the PowerPoint presentation.

e O O & O




can you generate a bar chart showing the improvement in time?

150, Time Spent: Manual Effort vs Al Effort

95%
Reduction!

S
(=]

150+

Time (minutes)

100}

50F

15 min

Manual Effort Al Effort
Method

Here's a bar chart comparing the time spent drafting the PowerPaint presentation manually (300
minutes) versus using Al (15 minutes). This clearly visualizes the significant reduction in time with Al

aszzistance. ]

MD:XPO)
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Challenge # 5:
Al Just for Fun




& corILOT B NOTEBOOK

« You

create a Marvel like superhero that repairs MRI scans

9 Copilot

Sure, let’s create a Marvel-like superhero! How about we call them “ScanGuard”?

ScanGuard

Real Name: Dr. Alex Carter

“imw Enghind v czner - 0L 20



Origin Story: Dr. Alex Carter was a brilliant radiologist working at a cutting-edge medical research facility. One day,
while experimenting with a new type of MRl machine designed to detect and repair cellular damage, an
unexpected power surge caused the machine to malfunction. The resulting explosion fused Dr. Carter’s DNA with
the machine’s advanced technology, giving them extraordinary abilities.

Super Powers:

*MRI Vision: ScanGuard can see through objects and people, detecting any abnormalities or damage at a cellular
level.

*Healing Touch: By focusing their energy, ScanGuard can repair damaged tissues and organs, effectively healing
injuries and illnesses.

*Data Manipulation: They can interface with any digital system, allowing them to correct errors in medical scans
and other digital data.

*Electromagnetic Pulse (EMP): ScanGuard can emit a controlled EMP to disable electronic devices or disrupt
harmful technologies.

Costume: ScanGuard’s suit is sleek and metallic, with glowing blue lines that mimic the look of MRI scan images.
The suit is equipped with various medical tools and gadgets, including a portable scanner and a healing device.

world helping hospitals and clinics repalr faulty MRI scans, diagnose difficult cases, and heal patients who have no
other hope.

(" ) | 7]
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Benefits of Alin HTM

e Develop New Skills

e Improved accuracy

e Increased efficiency

o Better decision-making

e Productivity / Cost savings

i ol otz 4 L



Challenges and Considerations

o Data privacy concerns
e Integration with existing systems
e Al is no replacement for human expertise

e Training and skill requirements

i ol otz 4 L



Al Is here

What it can do
Why it's needed
Al Tips
Examples of Al

N\

_ SAN GUARY

((&)) Supersichicopan

(Al Generated Image: ScanGuard)
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Thank You!

Mark Cooksey

ISO 13485 Quality Leader, Norton Healthcare
Mcooksey6@gmail.com

(502) 554-5206

"IMDE XPO
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